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About Sermon Library 

Overview

Sermon Library  is a programme for people in ministry who need to keep track of sermons, messages, 
devotionals, Bible studies and the like. It is simple to use yet has many features that enable you to keep 
track of your sermons.

Sermon Library  enables you to store records of sermons preached. Each record can store information 
such as,

·    Title
·    Date
·    Series name (if sermon is part of a series)
·    Theme
·    Filename (name of file the sermon in stored under from word processor)
·    Dated notes ( to record, for example, when and where a message we preached. This is 
very handy if you use the same message twice.)
·    Old Testament References
·  New Testament References
·    General comments
 

Other Features

In addition to simply storing information relating to sermons. Sermon Library has several other very useful
features. These include,

Opening a Sermon in your word processor - if you have recorded a filename for a particular 
sermon. 

By clicking on the  button on the toolbar, you can open the sermon file in your word processor, 
ready to make any changes necessary.

Printing the Sermon - just as you can open a file if the filename has been recorded, you choose to print 
the sermons without having to leave Sermon Library. 

Simply click the  button on the toolbar.

Search for a Sermon - if you have years of sermons, wading through paper copies can be a real 
headache. Sermon Library takes the hard work out of finding that elusive message. 

By clicking the  button on the toolbar you can choose search the database for the sermon, using 
the title, series or theme as your search criteria. You can also search for Bible References and Dated
Notes.



Sort your Sermons - Sermon Library will also allow you to sort your sermons. Like the search facility 
you can catalogue your messages by either title, date, series or theme. 

Simply click the  button on the toolbar.



The Toolbar

 
The toolbar is a quick was to navigate your way around and do many of the tasks Sermon Library was 
designed for.

To help you remember what each button does a pop-up hint appears when you move your mouse over 
the button. 

The buttons on the toolbar are,

 Open - if you have assigned a filename when you added a sermon record, then presssing the open 
button will open up your sermon file in your word processor so you can view and edit your message if 
required.

  Print - if you have assigned a filename when you added a sermon, the pressing the Print button with 
print the file.

  Add - pressing the add button will open a drop-down menu, giving you the various options regarding 
adding a new record.

 Edit - pressing the edit button will open a drop-down menu, giving you the various options regarding 
editing an existing record.

 Sort - pressing the sort button will open a drop-down menu to show the different ways you can sort 
the records stored in Semron Library

 Search - pressing the search button will bring up the search dialogue that will enable you to search 
the database for a particular sermon. You can choose to search by title, date, series or theme.

 Delete - pressing the delete button will delete the current record. A message box will appear asking 
you to confirm your actions.

 Help - launches this help file.

 Exit - exits Sermon Library.



Selecting a Series

When you are adding or editng    a record, you can automatically select a series by click on the  button 
located to the right of the series editbox. The Select a Series dialogue will appear. 

Select a series by clicking on the desired name and pressing the select button . Alternatively you can 
double click your selection in the Series list box.

Add a New Series Name

· To add a new series name, enter the name in the editbox located on the Select a Series 
dialogue.

· Press the Add button . The new name will then appear in the Series listbox.

Delete a Series Name

· If you need to delete a series name, select the name you want to delete from the series 
listbox.

· Click on the Delete button  . The name will then be deleted.



Add a Record
See also

To add a record select the Edit menu and the choose Add a Record.

Alternatively you can click on the Add button    on the toolbar.

Both these methods will reveal the pop-up menu which gives you five option,

·    Add a Record - choose this to start a new sermon record. Fill in the details of your 
sermon in the releveant boxes.

·    Note - choose this to add a dated note to an existing sermon record.
    
·    Old Testament Reference - choose this to add an Old Testament reference to and 
existing sermon record.
    
·    New Testament Reference - choose this to add an New Testament reference to and 
existing sermon record.
    
·    Comment - choose this to add a comment to an existing sermon record. (Note: There is 
only one comment section for each sermon record, but you can add several lines to this 
comment field.

When you choose an item from the Add menu, the Sermn Library Wizard will appear. Simply fill in the 
boxes with the details regarding your message.



See Also

Selecting a Date
Selecting a Series
Selecting a Theme
Selecting a Filename



To choose a series name, 
click on the series name 
you want and press select.



To add a new series name,
enter the new name in the box
and press ADD. The new name 
will then appear in the series listbox.



Selecting a Date

To automatically select a date, click on the    button. This will show the pop-up calendar. Select the 
required date and click on the    button on the bottom left hand corner . 

The year and month can be changed using the <<,<,>,>> located at the top of the calendar.
To exit the calendar with out selecting a date click on the cancel button    located in the botton right hand 
corner.



Select a Theme

When you are adding or editing a record, you can automatically select a theme by clicking on the  
located on page 1 of the Sermon Library Wizard. The Select a Theme dialogue will appear. 

Select a theme by either double clicking on your selection in the Theme listbox.

Alternatively you can click on your selection and pressing the select button . 

Add a New Theme Name

· To add a new theme name, enter the name in the editbox located on the Select a Theme 
dialogue.

· Press the Add button . The new name will then appear in the Theme listbox.

Delete a Theme Name

· If you need to delete a theme name, select the name you want to delete from the theme 
listbox.

· Click on the Delete button  . The name will then be deleted.



Select a Filename

Use the Select a Filename dialogue to choose the name of the word processor file that your sermon is 
stored in. This can then be used later for opening it directly from Sermon Library or printing a copy of 
your message.

Click on the button to open the Select a Filename dialogue.



Selecting a Date
Selecting a Series
Selecting a Theme



To delete a series name,
click on the name you want
to delete and press the DELETE
button.



Turns the calendar 
one month back.



Click on the cross button
to cancel date selection
and close the calendar.



You can select the date by
double clicking in the chosen date.



Choose date and click
on tick button to select date.



Turns the calendar
one month forward.



Turns the calendar
one year back.



Turns the calendar
one year forward.



To add a new theme. Type new
theme name into edit box
and press the ADD button. The
new name will appear in the theme
listbox.



To choose a theme name, 
click on the theme name 
you want and press select.



To delete a theme name,
click on the name you want
to delete and press the DELETE
button.



This is the theme listbox.
You can select a theme by
double clicking on the theme
name you want to record.



This is the series listbox.
You can select a serise by
double clicking on the series
name you want to record.



Add your sermon title here.



Add date here. Press 
for pop-up calendar.



Add series name here.
Press  button
for selection choice.



Add theme name here.
Press  button
for selection choice.



Add filename here. 
Press  to search
for word processor filename.



To Select a Filename

1. Select the directory where your sermon file
is kept.

2. Select the filename.

3. Click on Ok



Use the BACK and NEXT buttons to
turn the pages of the Sermon Library Wizard.



Select Ok to accept entries or changes made
and exit to main screen.



Press the cancel button to cancel
adding a record or changes made to 
an existing record.



Edit Existing Records

To edit existing records, first find the record you want to change. You can do this by using the search 
function. The record you want to change should have its details displayed in the top half of the main 
screen.

When the correct sermon record is displayed, choose Edit existing records from the Edit menu.

Alternatively you can click on the edit button  on the toolbar.

By either method the edit drop-down menu will appear, giving you the edit options. You can choose from 
the following,

· Sermon record
· Dated notes
· Old Testament Reference
· New Testament Reference
· Comments

When you choose one of these options, the Sermon Library Wizard will appear. You can then make the 
required changes. (Note: You can access all the pages once you are in the Sermon Library Wizard by 
pressing the NEXT or PREVIOUS buttons.)

When you have completed your changes press OK to save them and return to the main menu. 

To return to the main screen without saving the changes, pres the CANCEL button.

The following pages contain a navigation bar to help you with your editing. They are

· Dated notes
· Old Testament Reference
· New Testament Reference



Go to the first record.



Go to the previous record.



Go to the next record.



Go to the last record.



Insert a new dated note, Old Testament Reference
or New Testament Reference.



Delete the current dated note, Old Testament Reference,
or New Testament Reference.



Update data (this will save current changes).



Search for a Sermon

Sermon Library    has the ability to help you find a particular sermon.

To start a search, choose Find from the Tool menu. Alternatively click on the  button on the toolbar. 
From the drop-down menu choose Main Search. 

Using either methods will bring up the search dialogue. You may search in the following fields,

· Title
· Series
· Theme

Choose one of the search fields by clicking the appropriate radio button in the FIELDS box.

Enter what you are searching for (ie the title, series or theme that you want to locate), in the box at the top
of the dialogue.

Click on the LOCATE button to search the database. To find the next matching record choose LOCATE 
NEXT from the tools menu or the drop-down menu on the toolbar.

For details here for details on Wildcard searches.



In the FIELD box, click on the radio button
next to the field you want to search.



Enter the information you wish to
search for in this box.



Check the IGNORE CASE
button to search for both
capital and lower case letters.



Click on the FIND FIRST button 
to start the search.



Click on the FIND NEXT button to search
for the next matching record.



Click this button to go to first 
record in the Sermon Library Database.



Click this button to go to the
last record in the Sermon Library database.



If you want to make the search case sensitive,
Put a check mark in the case sensitive box.

(Note: Case sensitive searches take note of capital letters.)



The MATCH TYPE box allows you to choose how the
search will be conducted.

Choose ANYWHERE to find parts of words or titles,
(eg, to find the word grace in a title, or if you type in 
Gra it will find entries such as Grace, Gracious, Graceful.)

This allows you to search for a sermon
without knowing the whole title. For example, you could search 
for the word grace and find all the sermon titles
containing that word.

Choose BEGINNING to find words that are at the start of a
title or series or theme.

Choose FULL to match the full details (eg exact title, series or 
theme).



Search For Bible Reference

Click on the various areas of the map to find out what they are used for.

To start a search, choose Find from the Tool menu. Alternatively click on the  button on the toolbar. 
From the drop-down menu choose New Testament to search for New Testament References , choose 
Old Testament to search for Old Testament References or choose Notes to search for a dated note.

Enter the Bible book or comment you wish to search for and click Find. To arrow will go to the first record 
matching your search. Click Find Next to move to the next match.

When you have found the desired sermon, click Exit. This will return you to the main screen with the 
sermon you found highlighted.



Click Find to start search and
Find Next to search for next
matching record.



Enter what you are looking
for here.



Click on CLOSE to cancel the search
and return to the main window.



Exit and return to main screen.
The record matching your last seach
will be the current record on the
main screen.



The title of the current 
record is shown here.



The grid shows your record details



Delete a Record

To delete a record make sure the record you want to remove is showing in the top half of the screen. 

Choose Delete Record from the Tools menu. Alternatively click on the  button on the toolbar.



About Legacy of Love Software

Legacy of Love Software is a non-profit ministry of the Salvation Army Tarrawanna, a community church
located at Tarrawanna on the coast of New South Wales, about an hour south of Sydney, Australia.

All money raised through the sale of our applications is invested in people oriented programmes in our 
local community.

The aim of Legacy of Love Software is to write practical programmes for pastors as well as general 
Christian oriented software.

We believe in using our God given talents and interests to help others and contribute to our community 
support programme.

If you like our programmes, please register them, that way not only you benefit, but also we can put more 
back into our community.

All comments and suggestions and bug reports are welcome. Contact us on:

E-mail:              jevanu@tpgi.com.au

HomePage              http://www1.tpgi.com.au/users/jevanu/SATSoftwarefr1.htm

Snail mail:           The Salvation Army Tarrawanna
Legacy of Love Software
PO Box 259
Corrimal NSW 2518
Australia



Sorting the Sermons

After you enter sermon records you can then sort them. This will can be used to help you find certain 
messages or give you information as to how many times you have preached on a certain theme.

To start sorting, choose Sort from the Tools menu. Alternatively press the  button on the toolbar.

Using either methods will show the sort menu. You can sort by four different criteria,

· By title
· By date
· By series
· By theme



Registering Sermon Library 

Sermon Library is shareware. Please feel free to evaluate the usefulness of Sermon Library for a 
period of 30 days. If you wish to keep using it after that time you are required to register your copy.

By registering, you benefit, but also we can put more back into our community. 
All money raised through the sale of our applications is invested in people oriented programmes in our 
local community.

To Register:

In Australia

1. Fill out the registration form found in order.doc (found in the folder where Sermon Library 
is installed).

2. Send the form together with a cheque or money order    for $25.00 to,

Legacy of Love Software
The Salvation Army Tarrawanna
PO Box 259
Corrimal NSW 2518

Alternatively you can register online through PsL

Outside Australia

Registration of Sermon Library for those who live outside Australia is handled by PsL. If you 
live outside of Australia, you can register by 

· Internet
· Fax
· E-mail

Internet (online) Registration

Online orders are handled by PsL (Public software Library).

PsL is a service that handles credit card orders (and credit card orders only) for shareware 
programmers. Of course, this is not a free service. This means that the costs of handling the 
order are added to the registration fee, which becomes $US 25.00 in total.

The best way to place your order, is to use PsL's secure registration page on the web. You 
can find the link on our home page at 

http://www1.tpgi.com.au/users/jevanu/SATSermonfr1.htm

Note: Any questions about the status of the shipment of the order, registration options, 
product details, technical support, volume discounts, must be directed to Legacy of Love 



Software at jevanu@tpgi.com.au.

If you have any problems, questions, complaints, after placing your order (e.g.: you are have 
not received the registration number yet), do not contact PsL but contact us at 
jevanu@tpgi.com.au.

When placing your order, please mention the following details:

· What you wish to register: Sermon Library for $US 25.00, PsL product ID: #30200
· Your name
· Your postal address
· Your email address (registration number is sent to this address)
· Credit card type and number, expiration date and the name on the card if it differs 
from your name mentioned above.

· The name Sermon Library is to be registered to.
· Which version of Sermon Library you are registering (Win3.1 or Win95)

Fax Registration

This can only be done on the order form provided. Fill out the order form and fax to PsL. at 
713-524-6398 (U.S.A.).

PLEASE NOTE: When filling out the order form please TYPE or PRINT NEATLY . 

E-mail Registration 

This can only be done using the order.doc    that is found in the directory where you installed
Sermon Library. 

· Open the file using Write/WordPad or other word processor.
· Fill out the form
· Attach it to an e-mail and send to 30200@pslweb.com
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Order Form

SERMON LIBRARY 
(c) 1997 Legacy of Love Software 

How to Register

Use this registation form if you are registering:

1. In Australia AND paying by cheque for money order. (Cost $25.00 Australian)

2. Registering with PsL by Fax or E-mail AND paying by credit card (Cost $25.00 US)

SERMON LIBRARY REGISTRATION FORM
PsL Product #30200

(Please type or write neatly)

Name: ________________________________________ (this will be the name Sermon Library is 
registered under)

Postal Address: ____________________________________________

 ____________________________________________

Town:  ________________________________      State:
__________________________      

Postcode:                  ___________________    Country:  
___________________________

Fax:  _________________________________ (this will be where your registration code will 
be sent if you do not have access to e-mail)

E-mail:        _________________________________

Which version are you using (circle one)      Win3.1 Win95

(if    registering with PsL by Fax AND paying by credit card)

Credit Card Type:    (circle one)        Mastercard          Visa          American Express

Card number:    ________________________________________________

Expiry date: ______________________________________



Name on card: _________________________________________

Where to send the form

In Australia Enclose registration form and payment and sent to:
(cheques payable to The Salvation Army)

Legacy of Love Software
The Salvation Army
PO Box 259
Corrimal NSW 2518

To PsL
Fax:                713-524-6398    (in the United States)
E-mail to:      30200@pslweb.com



Backup and Restoring Data

Sermon Library has the ability to back up and restore the data you enter.

It is good practice to do regular backups.

Backups can be created by choosing Backup from the file menu.

Restoring data that has already been backuped up can be done by choosing Restore from the File menu.




